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Overview

1 Overview

This documentation describes how to install and use Processor Expert in conjunction with the 36VeXtremeSwitch component.

The 36VeXtremeSwitch component supports the MC36XSD 36 V Industrial Low Rpg(on) €Xtreme Switch. NXP's TWR-MC36XSDEVB

tower platform and FRDM-MC36XSD-EVB Freedom evaluation boards are based on this chip. See the related user guides and data
sheets for detailed information.

36 V eXtreme switch Processor Expert component, Rev. 2.0

NXP Semiconductors



2 36VeXtremeSwitch compatibility

2.1

Peripheral requirements

36VeXtremeSwitch compatibility

The following peripherals and resource requirements are critical to the MCU’s ability to handle a given part:

* SPI Module is required for communication (SI, SO, SCLK, CSB)
* GPIO is required for device reset (RSTB)

The following peripherals are not critical, but may be required to support other features:

* TPM/FTM timer (PWM, single channel) is required for external clock generation
» ADC and GPIO are required for current sensing (CSNS) and synchronization (CSNS SYNC)

2.2

Supported devices

This section describes which analog devices are supported by this component. It also compares the features and capabilities of the

supported devices.

The MC36XSD is part of a family of intelligent, dual high-side eXtreme switches designed for 36 V systems. This product family offers

1.0 Ato 12 A DC devices that are footprint and software compatible within the PQFN subfamily. Each device can be programmed to control

a broad range of loads, including lamps, LEDs, motors and solenoids.

The 36XSD family products differ in Rpgon) resistance of the outputs (see Table 1).

Table 1. Device features

» Normal operating range: 8.0 V to 36 V, extended operating
range: 6.0 Vto 58 V

» Open load detection (channel in OFF and ON state), also
for LED applications (7.0 mA typ.)

Device Common Features Device Specific Features
MCOBXSD200 + 3.3 V and 5.0 V compatible 16-bit SPI port for device con- | « Two fully-protected 6.0 mQ (at 25 °C) high-side switches
trol, configuration and diagnostics at rates up to 8.0 MHz | . Up to 9.0 A steady-state current per channel
* Separate bulb and DC motor latched overcurrent handling - - - -
MC10XSD200 - Sleep mode with minimal supply current (< 10 pA at 24 V) | ° Two fully protected 10 mQ (at 25 °C) high-side switches
« Parallel output operating mode with improved switching * Up to 6.0 A steady-state current per channel
MC16XSD200 synchronization _ - Two fully-protected 16 mQ (at 25 °C) high-side switches
. Ipd|V|dua|I¥ prqgrammable internal/external PWM clock « Up to 3.0 A steady-state current per channel
signals (switching frequency, duty cycle, slew rate,
switch-on time-shift)
« Overcurrent, short-circuit and overtemperature protection
with programmable auto-retry functions
* Accurate temperature and current sensing (high/low sens- | | g ° P :
MC50XSD200 ing ratios/offset compensation) Two fully-protected 50 mQ (at 25 °C) high-side switches

* Up to 1.2 A steady-state current per channel
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36VeXtremeSwitch compatibility

2.3 Supported MCUs

The 36VeXtremeSwitch component supports the products listed in Table 2.

Table 2. Supported products

Supported Products Kinetisszis;g:t Studio
TWR-K20D72M Yes
TWR-K70F120M Yes
TWR-K64F120M Yes
FRDM-K64F Yes
FRDM-KL25Z Yes

Compatibility with other MCUs and MCU boards depends on the peripherals and pin connections used with the boards.

24 Tower board settings

The TWR-MC36XSDEVB is a peripheral module circuit board that provides a means of exercising eXtreme Switch functions in a Tower
System environment. The Tower System includes a debug port and a communication port that connect to a PC and allow for the
downloading and debugging of application code using the Kinetis Design Studio IDE.

The board features:

+ Four eXtreme switch devices: MC06XSD200, MC10XSD200, MC16XSD200, MC50XSD200
» SPI communication in daisy chain mode with four devices (selectable by switch)

+ Single SPI communication support

* On-board LEDs indicating ON/OFF status for each high-side channel

* An MCU A/D converter pin for current/temperature sensing of four devices

To run the example projects that are part of the component package, the TWR-MC36XSDEVB board must be in a Tower System
configuration with one of the supported MCU boards (TWR-K20D72M or TWR-K70F 120M). Figure 1 shows how to connect the hardware.
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36VeXtremeSwitch compatibility

TWR-MC36XSDEVB

Edge of board with
white stripe connects
to white Elevator connector

8.0Vto36V
Power Supply

Standard A to Mini-B
USB Cable

aaa-024950
Figure 1. Hardware configuration
Switch SW2 on the TWR-MC36XSDEVB board must be set as shown in Table 3.
Table 3. TWR-MC36XSDEVB switch settings
Connection
SPI Work Mode Description
SW21 SW2 2 SW2 3 SW24
Single Connect MC06XSD200 only ON OFF ON OFF
Daisy Chain Connect the four devices by daisy chain OFF ON OFF ON
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36VeXtremeSwitch compatibility

2.5 Freedom board settings

The FRDM-MC36XSD-EVB consists of four power high-side channels driven through a parallel and SPI interface. The two devices on
board are daisy chained. The board can be configured for use with a FRDM-KL25Z board and the 36VeXtremeSwitch component.
Note:

When using the FRDM-MC36XSD-EVB, make sure that the maximum supply voltage (VPWR) stays
within the 5.0 V to 36 V range. Operating outside this range may cause damage to the board.

To configure the FRDM-MC36XSD-EVB for use with the FRDM-KL25Z and Kinetis Design Studio, do the following:
1. Connect the FRDM-MC36XSD-EVB to the FRDM-KL25Z using the Arduino™ connectors on each board.
2. Connect the USB cable (not supplied with the kit) between the PC and the USB port labeled SDA on the FRDM-KL25Z board.

3. With the power switched off, attach the DC power supply to the VBAT and GND screw connector terminal (J20) on the evaluation
board.

4. Connect the load to the screw terminal (J21). Figure 2 illustrates the hardware configuration using a FRDM-KL25Z.

For more details on setup of the FRDM-KL25Z, refer to the FRDM-KL25Z tool summary page at http://www.nxp.com/FRDM-KL25Z or
the material at http://www.element14.com/community/docs/DOC-49219

50Vto36V,20A +
DC power supply ~

e

FRDM-MC36XSD-EVB

Workstation

Standard A to Mini-B

USB Cable FRDM-KL25Z

aaa-024252

Figure 2. FRDM-MC36XSD-EVB configured for use with a FRDM-KL25Z board
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3 The 36VeXtremeSwitch component

The 36VeXtremeSwitch component

The 36VeXtremeSwitch component is located in the Components folder in the active projects window (see Figure 3). This folder contains

two subfolders:

» Referenced_Components contains components to configure SPI communication properties.

+ XSD1:36VeXtremeSwitch contains the component to configure the 36 V eXtreme Switch component features.

The functionality of the 36VeXtremeSwitch depends on the component property settings assigned through Processor Expert.

4 (= Components

4 (= Referenced_Components

%3 SM1:SPIMaster_LDD[SPImaster

4 @ XSD1:36VeXtremeSwitch
g SPI_Devicel:SPI_Device
ﬁ RSTB1:BitIO_LDD

i Init API
i ReadRegister

i WriteRegister

] GetStatus

] GetFaultinfo

B SetPWMDuty

[ SetPWMState

I FeedWatchdog

[ ConfigureWatchdog
[H Diagnosis

I ConfigureMonitoring

Figure 3. 36VeXtremeSwitch Processor Expert component

The component includes Help documentation, which can be accessed by right-clicking the 36VeXtremeSwitch component in the
component tree. The Help on Component window provides information on all properties and methods of the component. Access the

Typical Usage section to view examples showing how to work with APl methods.
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The 36VeXtremeSwitch component

3.1 Component settings

Selecting the 36VeXtremeSwitch component in the component tree gains access to properties in the Component Inspector. These
properties determine the component’s general settings and its behavior after initialization. Some of these properties can later be changed
in the application code by using the provided API.

% *Component Inspector - X501 &3 % Components Library Basic Ceissen
Properties . Methods | Events
Marne Value Details
Component Name X501
SPI_Device SPI_Device
Use 8-bit 5PT communitation no
Autematic watchdeg toggling yes
. Reset Pin control Enabled
4 Devices On Daisy Chain 1
Configuration for deviced Configuration_0
a Configurations 1
4 Configuration_0 1
4 Global Configuration
PWM channel 0 Enabled
PWM channel 1 Enabled
Parallel Mode Disabled
Track & Hold current sensing  Disabled
Watchdog Enabled
VDD failure detection Disabled
Overvoltage protection Enabled
C5NS Pin Function Disabled
4 Output 2
a HS0
Direct control Disabled
PWM duty 0 D|
PWM Switch-on Delay Mo Delay
PWM clecksource Internal
External PWM Clock Divider 256
Overcurrent profile DC Maotor
Short circuit detection Disabled

OpenlLoad Detection in OM  Disabled
OpenlLoad Detection in OFF Disabled
Slew rate Medium SR
Random Current Offset Add random offset
Max Auto-Retry Count Infinite retries
Auto-Retry Period tAUTO_10
Auto-Retry Function Disabled
Low Current Threshold 1.OCL3
Medium Current Threshold I_OCM1L
High Current Threshold I.OCHL
Threshold Activation Times tOCHL and tOCML_L
Current Sense Ratio high-current
. HS1
Aute Initialization yes

Figure 4. 36VeXtremeSwitch component properties

SPI communication — SPI_Device link and 8/16-bit SPI selection. The eXtreme switch uses 16-bit communication, but for MCUs with
only 8-bit communication, the 16-bit frame can be divided into two 8-bit frames.

Watchdog toggling — When automatic watchdog toggling is enabled, the watchdog bit is toggled with every SPI read/write operation.
When Watchdog toggling is disabled, application code must call the FeedWatchdog method periodically.

Reset Pin control — Links to the BitlO_LDD component used as the reset pin.
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The 36VeXtremeSwitch component

Devices On Daisy Chain — The number of devices connected in a daisy chain. Each device can have its own configuration or all devices
can share the same configuration.

Device global configuration - Device configuration or common features for both channels.

*« PWM channel 0 and PWM channel 1 — These properties activate the PWM control mode on channels 0 and 1. To improve switching,
synchronize between these channels by enabling Parallel Mode.

» Watchdog — When enabled, watchdog feeding must be sent to the device to avoid a watchdog timeout. VDD failure detection and
Overvoltage protection enable failure detection on VDD and VPWR.

» CSNS pin — This property outputs an analog signal to indicate current on channel 0, current on channel 1, summed current of both
channels and temperature. When Track & Hold current sensing is activated, the value of the channel's load current is kept available
after turn-off.

Output configuration — Channel specific configuration such as PWM duty, overcurrent profile and threshold, or open load detection.

» Each channel is controlled either internally by PWM or externally by using direct inputs (IN1, IN2). External control is enabled by the
Direct control property. When Direct control is disabled, the direct input pins have no function.

» For PWM control, set the clock period values for the PWM duty and the PWM Switch-on Delay properties. Also set the PWM clock
source for either an internal or an external clock. If an external clock is selected, the External PWM Clock Divider property must be
set to the appropriate value.

» The Output configuration section contains settings for short-circuit and open load detection, slew rate and current thresholds.
Properties in this section set Current Sense Ratio values and Random current offset values for current sensing.

Auto Initialization — When auto initialization is enabled, the Init method is called automatically within the PE initialization function
PE_low_level_init().

36 V eXtreme switch Processor Expert component, Rev. 2.0
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The 36VeXtremeSwitch component

3.2  SPI configuration

The 36VeXtremeSwitch uses the SPI communication protocol to communicate with the MCU. This protocol is implemented by the
SPIMaster_LDD component, which resides in the referenced components (shared components) folder in the Components panel (see
Figure 5). However, this component does not handle arbitration for simultaneous communication requests on the SPI bus. This
functionality is implemented by the SPI_Device component, which is exclusively inherited by the 36VeXtremeSwitch component.

In SPIMaster_LDD, the (MISO, MOSI, CLK) pins and timing settings must comply with the specifications in the relevant MC36XSD data
sheet. The maximum admissible communication frequency is 8 MHz.

The CSB (chip select) pin must be set separately in the BitlO_LDD component (exclusively inherited by SPI_Device). Because of
component implementation limitations, the user must initialize the CSB pin value to 1, as specified in the data sheet.

5. Components - SetPWMDutyDaisy 532 = [m

SN T
4 (= Generator_Configurations
& RAM
& FLASH
&= 0Ss
4 (= Processors
. &P Cpu:MK20DX256VLL7
. &9 Cpu:MK20DX256VLL7
4 (= Components
4 (= Referenced Components

3 SMLSPIMaster LDD[SPImaster] |
- ) TUL:TimerUnit_LDD
4 @ XSD1:36VeXtremeSwitch
4 B3 SPI Devicel:SPI Device
| 88 CSpinl:BitlO_LDD |
~ BH RSTBL:BiIO_LDD
M Init
[ ReadRegister
M WriteRegister
] GetStatus
M GetFaultinfo
[ SetPWMDuty
[ SetPWMState
] FeedWatchdog
[ ConfigureWatchdog
[ Diagnosis
[ ConfigureMonitoring
= PDD

Figure 5. SPI chip select configuration
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The 36VeXtremeSwitch component

3.3 Component API

The 36VeXtremeSwitch component contains API functions that allow application code to dynamically configure a device in real-time. To
view the available methods and events, click to expand the component in the Component folder in the Components Panel (see Figure 3).

Methods and events marked with green tick marks are included when source code is generated; methods and events marked with black
crosses are not included. To change these settings, go to the Component Inspector panel and select the Methods tab. Note that some
methods/events are always generated because they are needed for proper functionality. This forced generation of methods/events
depends on various combinations of component property settings.

For a summarization of available APl methods and events and their descriptions, see Table 4.

Table 4. 36VeXtremeSwitch component API

Method Description

Init Initializes the device and applies settings selected in the component properties. This includes initialization of inherited
components and other features.

Deinit Irl)n%igieti)alizes the device; sets the reset pin to low and consequently clears all device registers (puts the device in Sleep

GetQuickStatus Returns the current status of the device

GetChannelStatus Returns fault information for all available channels

ReadRegister Reads a value from the selected register via the SPI

WriteRegister Writes a value to the selected register via the SPI

GetStatus Returns current general status information

GetFaultinfo Returns fault status information

SetPWMDuty Sets the PWM duty cycle for the specified channel

SetPWMState Enables or disables the PWM channel

FeedWatchdog Feeds the watchdog to avoid a watchdog time-out when the watchdog is enabled

ConfigureWatchdog Enables or disables the watchdog

Diagnosis Runs a diagnosis routine t_hat re_turns the chann_el configuration, product ider]tificgtion, _current logic status of direct inputs,
report of external clock failure (if external clock is enabled) and report of calibration failure

ConfigureMonitoring Sets current/temperature monitoring option of CSNS pin

36 V eXtreme switch Processor Expert component, Rev. 2.0
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The 36VeXtremeSwitch component

3.4 Components used by the 36VeXtremeSwitch component

The 36VeXtremeSwitch uses several components that are shared or inherited. Figure 6 illustrates these components and their relationship

to each other. A description of the inherited and referenced components appears immediately below Figure 6. The functionality of the
36VeXtremeSwitch in terms of communication, control, etc. depends on these components.

MISO, MOSI, SCLK

36VeXtremeSwitch Component

SPI_Device

SPI_Master_LDD
(SPIO) -« BitlO_LDD
cs Current

Sensing CSNS

<«——| Bitlo_LDD
RSTB

Figure 6. Components used by the 36VeXtremeSwitch
Referenced components
SM1:SPIMaster_LDD Configuration of SPI communication—Referenced by SPI_Device
XSF1:36VeXtremeSwitch (configured features of 36XSD)

SPI_Device1:SPI_Device Adds bus allocation of SPI communication
CSPin1:BitlO_LDD Software chip select
RTSB1:BitlO_LDD Input/output reset pin

36 V eXtreme switch Processor Expert component, Rev. 2.0
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Installing the Processor Expert software

4 Installing the Processor Expert software

This chapter describes the installation of Kinetis Design Studio and the use of Processor Expert for application development. Processor
Expert software is available as part of the CodeWarrior Development Studio for Microcontrollers, Kinetis Design Studio or as an
Eclipse-based plug-in for installation into an independent Eclipse environment (Microcontroller Driver Suite). For more information about
Processor Expert refer to the following link: www.nxp.com/processorexpert.

4.1 Installing Kinetis Design Studio

This procedure explains how to obtain and install the latest version of Kinetis Design Studio (version 3.2.0 in this guide). The procedure

for CodeWarrior installation is very similar.

NOTE

The component and some examples in the component package are intended for Kinetis Design
Studio 3.2.0 (and above) and CodeWarrior 10.6 (or above). If Kinetis Design Studio 3.2.0 and
CodeWarrior 10.6 are already installed on the system, skip this section.

1. Obtain the latest Kinetis Design Studio installer file from www.nxp.com/KDS.

2. Run the executable file and follow the instructions.

4.2 Downloading the components and example projects
This section describes how to get the 36VeXtremeSwitch component and the example projects from NXP’s website.
To download the project and its associated components:
1. Go to www.nxp.com/36V-EXTREMESWITCH-PEXPERT and download the example projects and the 36VeXtremeSwitch

component zip file.

2. Unzip the downloaded file and check that the folder contains the files listed in Table 5

Table 5. Contents of the downloaded zip file

Folder Name

Folder Contents

Component

Processor Expert components folder

36VeXtremeSwitch_Bxxx.PEupd

36VeXtremeSwitch component update file

SPI_Device_Bxxx.PEupd

SPI_Device component update file

KDS_Examples

Example projects folder for Kinetis Design Studio

FRDM-MC36XSD-EVB

Examples using MC36XSD Freedom board (two devices in daisy chain)

FRDM-K64F or FRDM-KL25Z

Examples for specific MCU Freedom board (K64 or KL25)

XSD_FRDM-xxx_ChannelMonitoring

Current and temperature measurement with console output

XSD_FRDM-xxx_FreeMASTER

Changing duty cycle, current/temperature measurement and fault monitoring using FreeMASTER
|

XSD_FRDM-xxx_SetPWMDutyDaisy

Simple example showing changing duty cycle

TWR-MC36XSDEVB

Examples using MC36XSD Tower board (one or four devices)

TWR-K20D72M or TWR-K64F120M or
TWR-K70F120M

Examples for specific MCU Tower board (K20, K64 or K70)

XSD_TWR-xxx_ChannelMonitoring

Current and temperature measurement with console output

XSD_TWR-xxx_FreeMASTER

Changing duty cycle, current/temperature measurement and fault monitoring using FreeMASTER
GUI (only one device)

XSD_TWR-xxx_SetPWMDutyDaisy

Simple example showing changing duty cycle (four devices)

XSD_TWR-xxx_SetPWMDutySingle

Simple example showing changing duty cycle (one device)

36 V eXtreme switch Processor Expert component, Rev. 2.0
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Installing the Processor Expert software

421

To install the 36VeXtremeSwitch component:

Importing 36VeXtremeSwitch components into the Processor Expert library

1. Launch Kinetis Design Studio. When the Kinetis Design Studio IDE opens, go to the menu bar and click Processor Expert ->

Import Component(s).

2. In the pop-up window locate the component file (.PEupd) in the folder 36VeXtremeSwitch_PEx_SW\Component. Select
36VeXtremeSwitch_bxxxx.PEupd and SPI_Device_bxxxx.PEupd files, the click Open (see Figure 7).

3. Select the repository where the imported packages are to reside, then confirm by clicking OK. (Note that, in CodeWarrior,
components are imported to a predefined default repository. Kinetis Design Studio offers users a choice to select the repository.)

File Edit Source Refactor Navigate Search Project Run Window Help

g s e SV P-&-ime v SO - uikaces [ | [0 ) 4 Debug
ide views
[ Project Explorer 32 =0 porCotponenis) = O %) Component.. 22 =8
SR-3 - Basic -Advanzed <« N
= LOj
» 36VeXtremeSwitch_PECSW » Component ~ | 49 W Search Component £
Organize v Newfolder A @
e Neme Type Size
L __ 36VextremeSwitch_B1404.PEupd PEUPD File 135KB
8" | sProeice siaonpeupa PEPD il Y0
ol
. Components 53 B v=0O "
File name: "36VextremeSwitch_B1404.PEupd’ "SPL Devicr v
Cancel
[22 Problems &2 =B
Qitems.
Description
0 items selected

Figure 7. Importing the 36VeXtremeSwitch component

4.If the import is successful, the 36VeXtremeSwitch component is in Components Library -> Software -> User Components (see

Figure 8). The component is ready to use.

% Component Inspector % Components Library &2 00

Alphabetical | Categories
¥

Component
(= Kinetis
» £ MCUonEclipse
4 (= My Components
4 (= Software
4 (= User Components

EmbSys Registers = |ml

Processors | Board Configurations

All repositories

v| |Apphcab|eto project -

Description

b3 J6VeXtremeSwitch

36V eXtremeSwitch connected to 5P bus I

(E BCC_MC3377x
e GendeXtremeSwitch
MYHEridge

Processor Expert support for Battery Cell Controller boards based on MC...
Processor Expert support for 12V/32V eXtremeSwitch devices.

Communication with SPI device placed on SPI bus |

SPI Device
ThreePhaseMotorControl
@ ThreePhasePredriver
Mo project focused, filtering disabled

Three-Phase BLDC Motor Control
Three Phase FET Pre-Driver GD3000/MC33937/MC34937

Figure 8. 36VeXtremeSwitch component location after importing into Kinetis Design Studio
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4.2.2

Installing the Processor Expert software

Importing an example project into Kinetis Design Studio

The following steps show how to import an example from the downloaded zip file into Kinetis Design Studio.

1.1n the Kinetis Design Studio menu bar, click File->Import....In the pop-up window, select General->Existing Projects into

Workspace, then click Next.

= C/C++ - Kineti:

Edit Source Refactor Mavigate Search Project Run Processor Expert Window Help

New
Open File...
Close
Close All
Save

Save As...
Save All
Revert
Move...
Rename...
Refresh

Convert Line Delimiters To
Print...

Switch Workspace
Restart

g | Export..
Properties

1 shb_test_Debug PNE.launch [shb_test..]
2 main.c [shb_test_kl27z/source]

3 fsl_dspi.c [shb_test_kbdf/drivers]

4 spi_aml.c [shb_test_kb4f/source/..]

Exit

Al+Shift+N ¥

Ctrl+W

Ctrl+Shift+W

Ctrl+5

Ctrl+Shift+5

Alt+Enter

Figure 9. Importing an example project

TE B 0GR -IdE S

>l

= O 4y CompenentInspector £y Components Libr

Select

Create new projects from an archive file or directory.

Select an import source:

type filter text

4 = General
[T Archive File
L, File System
[7] Preferences
» B O
- Component Development Environment
> = CVS
> = Git
> Install
. (= Processor Expert
> Project of Projects
., Remote Systems
» (= RPM
Run/Nshin

TR EE

Cancel

2. Click Browse and locate the folder where the downloaded example files were unzipped. Find the folder
36VeXtremeSwitch_PEx_SW\KDS_Examples and select a project to import. Then click OK.

3. With the project now loaded in the Select root directory box, click the Copy projects into workspace checkbox. Then click
Finish. The project is now in the Kinetis Design Studio workspace where it can be built and run.

4.3
component

Create a new project with Processor Expert and 36VeXtremeSwitch

If the example project is not used, the following instructions describe how to create and setup a new project that uses the
36VeXtremeSwitch component. If the 36VeXtremeSwitch component is not already in the Processor Expert library, follow the steps in

Section 4.2.1, "Importing 36VeXtremeSwitch components into the Processor Expert library".

1. In the Kinetis Design Studio menu bar, select File->New->Kinetis Project. When the New Kinetis Project dialog box opens, enter
a project name into the text box, then click Next.

2.In the Devices dialog box, select the MCU class to use (in Fig 9 MKL25Z128xxx4 has been selected). Then click Next.

3. In the Rapid Application Development dialog box, make sure that the Processor Expert option is selected. Then click Next.

4.In the Processor Expert Target Compiler dialog box, select the compiler to be used (GNU C Compiler has been selected in

Figure 10).
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Installing the Processor Expert software

# New Kinetis Project

@231

Devices

Select the derivative you would like to use

Processor to be used:

type filter text

. Boards
4 Processors
> Kinetis E
> Kinetis K
4 Kinetis L
> MELDx
> MELLx
a MEL2x
> KL24Z (48 MHz)
a Kl 45 hH
MEL2523 oot
MEL25Z6400¢4

Creates project for MKL25712800¢d derivative

< Back Next »

# New Kinetis Project

Rapid Application Development
SDK, Processor Expert

Kinetis SDK | Mone

Environment variable

(@ Absolute path

Processor Expertt

Start with perspective designed for
(2) Hardware configuration (pin muxin
(@ Use current perspective
Initialize all peripherals
Project Mode
() Linked

(@ Standalone

I this project is expected to use the Kinetis 5D
Kinetis SDK inte this tool using Help -> Install
your Kinetis 5DK folder to find the appropriate]

Enable Processor Expert in the project for MC
initialization.

@.z&-}

% New Kinetis Project

Processor Expert Target Compiler
Target compiler

Target compiler

GMU C Compiler
AR ARM C Compiler
Keil ARM C/C++ Compiler

Nea> || Fnisn W

Cancel

Figure 10. Selecting a device, the Rapid Application Development options and compiler

5. Figure 11 shows the Project Explorer panel and the Components panel after the project has been successfully created.

[75 Project Explorer 53

» [ Example]

7. Components - Example i3

4 (= Generator_Configurations
@ FLASH
> = O5s
4 (= Processors
» 4P Cpu:MKL25Z128VLK4
+ = Components
> = PDD

Figure 11. Project Explorer and Components panel with the project created

4.4

Setting up the Project

Once the new project has been created and 36VeXtremeSwitch component added into it, it must be set up. Read Section 3.1, "Component
settings" describing the capabilities of the component and what is required to configure it properly.
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36VeXtremeSwitch uses several components (see Figure 12). Configure all the components in this order:
1. Set up referenced SPI_Master_LDD component.
2.Set up CS pin under inherited SPI_Device component.
3. Set up 36VeXtremeSwitch component.

T Components - Bcample 57 = & B ¥ = O

4 (= Generator_Configurations
i FLASH
> = 05s
4 (= Processors
. |6 Cpu:MKL25Z128VLK4
4 = Components
4 (= Referenced_Components
1 - 53] SM1:5PIMaster LDD[S
3 4 B3 XSD1:36VeXtremeSwitch
a [ SPI_Devicel:SPI Device
2 8 CSpinl:Bitl0_LDD
@J RSTBPRinl:BitIO_LDD
M Init
M ReadRegister
| WriteRegister
M GetStatus
M GetFaultlnfo
I SetPWMDuty
I SetPWMState
M| FeedWatchdog
M ConfigureWatchdog
M Diagnosis
M ConfigureMonitoring
> (= PDD

Figure 12. Setting up the components

4.5 Generating Driver Source Code

After the components are configured, the next step is to generate the driver code that will be incorporated into the user application. The
process is as follows:

1. Click on the Generate Processor Expert Code icon in the upper right corner of the Components panel.

tT. Components - Bample 52 = \!) ¥ = B Iy Project Explorer 2 = <q}==(> = =0
4 (= Generator_Configurations 4 =5 Example
3 FLASH - [ Includes
> = O%s » [= Documentation
4 (= Processors . == Generated Code
, Q Cpu:MKL257128VLKY » [= Project_Settings
4 (= Components 4 = Sources
. = Referenced_Components - lc] Events.c
, @ X5D1:36VextremeSwitch | [n] Events.h

> (= PDD fle main.c
. [ Static_Code
% ProcessorExpert.pe
= ProjectInfoxml

Figure 13. Generating the source code and the code location
The driver code for the eXtreme Switch is generated into the Generated_Code folder in the Project Explorer panel. The component only

generates the driver code. It does not generate application code. Figure 13 shows the locations of the generated driver source and the
application code.
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4.6 Writing Application Code

All application code must reside in the Sources folder in the user’s project directory. The user may modify the code in main.c and
Events.c, but must retain the original comments related to usage directions.

To add a component method into the application source code:

1.1n the Components view for the project, click on Components folder and select a component. Find the method to be added to the
code.

2.Drag and drop the method directly into the source code panel.

3. Add the appropriate parameters to the method. Hovering the mouse over the method displays a list of the required parameters.

For example, the user can open the 36VeXtremeSwitch component method list, drag and drop SetPWMDuty to main.c and add the
necessary parameters (see Figure 14).

[ Project Explorer 52 = <§>| e T = 0O [ main.c 52 = 7
a |5 Bample
> [ Includes
> [= Documentation
» [= Generated_Code

1

/¥ MODULE main */ -

@ 0o

/* Including needed modules to compile this medule/procedure */
#include "Cpu.h"

» (= Project_Settings 2 #include “Events.h”
4 [= Sources 3 #include "X5D1.h"
. [£) Events.c 4 #include “"SPI_Devicel.h”
5 #include "CSpinl.h"
» bhl Events.h & #include "RSTBPinl.h"
|2 main.c 7 #include "SM1.h"

> [= Static_Code
% ProcessorExpert.pe
[ Projectinfoxml

/* Including shared modules, which are used for whole project */
#include "PE_Types.h”
#include "PE_Error.h”
#include "PE_Const.h™
42 #include "I0_Map.h" [
v = H fS /* User includes (#include below this line is not maintained by Processor Expert|

LWL WL W L R R R

o@D

5. Components - Example i3

t -save -e97@ Disable MISRA rule (6.3) checking.
int main(void)
t -restore Enable MISRA rule (6.3) checking. */

4 (= Generator_Configurations
i FLASH
> = 08s
4 (= Processors
. 4 CpuMKL25Z128VLK4
4 (= Components

/* Write your local variable definition here */
XSD1_result error = ERR_OK;
uint1l6_t dutyCycleChe[4] = { 256, 256, 256, 256 };
: (= Referenced_Components uintls_t dutyCycleChl[4] = { @, @, 8, @ };
4 E3 X5D1:36VeXtremeSwitch
4 SPI_Devicel:5PI_Device
%) CSpinl:Bitl0_LDD
8] RSTEPinL:BitlO_LDD

H Init

THIS CODE!!! ***

/*¥** Processor Expert internal initialization. DON'T REMOV
PE_low_level init();
/*** End of Processor Expert internal initi

zation.

* Write your code here */
Channel @ */

ReadRegist
" Wea. Regl.s = error = X501 _SetPWMDuty(@, dutyCycleCha);
H| WriteRegister “ Channel T

M| GetStatus

error |= XSD1_SetPMDuty(1, dutyCycleChl);

M| GetFaultinfo |
M SetPWMDuty Don't write any code pass this line, or it 11 be deleted during code ge|
CetPWIvState RTOS startup code. Macro PEX_RTOS_START is defined by the RTOS component.|

#ifdef PEX_RTOS_START |
PEX_RTOS_START(); /* startup of the selected RTOS. Macro is|
#endif

H| FeedWatchdog
M ConfigureWatchdog

| Diagnosis End of RTOS startup code. /
M ConfigureManitoring Processor Expert end of main routine. DON'T MODIFY THIS CODE!!! *%*/
. (= PDD "33}

Processor Expert end of main routine. DON'T WRITE CODE BELOW!!! **¥*/
End of main routine. DO NOT MODIFY THIS TEXT!!!

Figure 14. Adding component methods

Hovering the mouse over any of the methods displays a description of the method, including a list of required parameters.

36VeXtremeSwitch component encompasses a help, which describes component properties, methods and typical usage. To show the
help, do the following:

* In the Components view, right click the 36VeXtremeSwitch component and select Help on Component.
A web page displays with the Help information.
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Compiling, Downloading and Debugging

To compile a project, click the compile icon in the toolbar (see Figure 15).

The process for downloading an application onto a board in Kinetis Design Studio may differ according to the type of MCU board being
used. For more information, see the Kinetis Design Studio user's guide. To download and debug on a FRDM-KL25Z MCU board, do the

following:

1. Click the arrow next to the debug icon in the toolbar and select Debug Configurations... (see Figure 15).

File Edit Source Refactor MWavigate Search Project Run  Processor Expert Window Help

[ ;‘:‘;.:"*m‘ﬁi '&"L':"{E,vri_;}v

Figure 15. Compile and debug

2.In the Debug Configurations dialog box, click Example_Debug_PNE under GDB PEMicro Interface Debugging (see
Figure 16).

3. Make sure that C/C++ Application contains the path to the .elf file of the project (see Figure 16).

]

% Debug Cenfigurations

Create, manage, and run configurations

= )
= %| = T Mame: Example_Debug_PME
type filter text = Main ﬁDebugger B Startup| B Source| ] Common
[T] C/C++ Application
= Project:
& | C/C++ Attach to Application
[E] C/C++ Postmortem Debugger Example Browse...

[T] C/C++ Remote Application
[t] GDB Hardware Debugging

. [C] GDB OpenQCD Debugging
GDB PEMicro Interface Debugging

Specify the number of additional EIf Files you wish to program: Generate EIf Fields

C/C++ Application:
I Debug/Example.elf

. [©] GDB SEGGER J-Link Debugging [ Wariables... | | Search Project...] | Browse... |
B Launch Group Build {if required) before launching
Build configuration: | Use Active v|
Enable auto build Disable auto build
@ Use workspace settings Configure Workspace Settings...
Filter matched 16 of 25 items il =
'/?3' [ Debug ] | Close

Figure 16. Downloading the application (a)

4. Click the Debugger tab and set the Interface option to OpenSDA Embedded Debug - USB Port. Then click the Refresh button
next to the Port setting to update the list of available USB ports (see Figure 17).

5. Make sure that the Target is set to KL25Z128M4. If not, change the target by clicking the Select Device button. In the Select
Target Device dialog box go to Kinetis L -> KL2x -> KL25Z128M4 and confirm by clicking the Select button.

6. Click Debug. Kinetis Design Studio will download and launch the program onto the board.
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% Debug Configurations

Create, manage, and run configurations

f.

% |
type filter text

C/C++ Application

C++ Attach to Application

C++ Postmortem Debugger

C/C++ Remote Application

GDB Hardware Debugging

GDB OpenOCD Debugging

4 GDB PEMicro Interface Debugging
[€] Example_Debug_PNE

GDB SEGGER. J-Link Debugging

= Launch Group

Filter matched 16 of 28 items

Plugin has not been registered. Some functionality may not be available.

Mame: Example_Debug_PNE
D Main

Software Registration

i Startup | & Source| ] Common

Please register your software te remove this message.
b

m

PEMicro Interface Settings

Interface: OpenSDA Embedded Debug - USE Port

Port: USEL - OpenSDA (OpenSDA)

Vendor: Freescale Family: KL2x Target: KL25Z128M4|

Core:

Specify IP Specify Network Card IP

Additional Options

Apply Revert

Debug %—] [ Close

Figure 17. Downloading the application (b)
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5 References

The following are URLSs for additional information related to NXP products and application solutions:

Table 6. References

NXP.com Support Pages Description URL
MC36XSD Product Summary Page | www.nxp.com/MC36XSD
TWR-MC36XSDEVB Tool Summary Page www.nxp.com/TWR-MC36XSDEVB
FRDM-MC36XSD-EVB Tool Summary Page www.nxp.com/FRDM-MC36XSD-EVB
Tower System Modular
Tower System Development Board WWW.Nnxp.com/tower
Platform
Kinetis Design Studio Software www.nxp.com/KDS
CodeWarrior Software www.nxp.com/codewarrior

Processor Expert Code

.nxp.com/video/ - rt-code-model-cod ior-code-walkth h:PROEXP
Proce: Code Walkthrough Video www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthroug

CODMODCW_VID

5.1 Support

Visit www.nxp.com/support for a list of phone numbers within your region.

5.2 Warranty

Visit www.nxp.com/warranty to submit a request for tool warranty.
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www.nxp.com/FRDM-MC36XSD-EVB
http://www.nxp.com/products/discretes-and-logic/mosfets/high-side-switches/36v-industrial-low-rsubdson-sub-extreme-switch:MC36XSD
www.nxp.com/warranty
http://www.nxp.com/products/discretes-and-logic/mosfets/high-side-switches/embedded-component-36v-tower-system-extreme-switch-module:TWR-MC36XSDEVB
www.nxp.com/tower
www.nxp.com/KDS
www.nxp.com/codewarrior
www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID
www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID
http://www.nxp.com/support/sales-and-support:SUPPORTHOME
http://www.nxp.com/support/sales-and-support/buy-direct/returns-and-warranty-information:WTBUY_DTD_RETURNS?tid=vanwarranty
http://www.freescale.com/support
http://www.freescale.com/support
http://www.freescale.com/warranty

Revision history

6

Revision history

Revision Date Description of Changes
1.0 2/2016 + Initial release
* Added support for FRDM-MC36XSD-EVB
* In the Supported products table (Table 2)
—  Added rows for FRDM-64F and FRDM-KL25Z
—  Deleted references to CodeWarrior support
—  Added KDS support for all listed boards
2.0 10/2016 » Replaced jumper setting references to switch setting references

Added section on FRDM-MC36XSD-EVB settings
Added new version of Section 4, "Installing the Processor Expert software"
In Section 5, "References"

—  Added references to FRDM-MC36XSD-EVB

—  Removed references to CodeWarrior
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How to Reach Us:

Home Page:
NXP.com

Web Support:
http://www.nxp.com/support

VRoHS

Information in this document is provided solely to enable system and software implementers to use NXP products. There
are no expressed or implied copyright licenses granted hereunder to design or fabricate any integrated circuits based on
the information in this document. NXP reserves the right to make changes without further notice to any products herein.

NXP makes no warranty, representation, or guarantee regarding the suitability of its products for any particular purpose,
nor does NXP assume any liability arising out of the application or use of any product or circuit, and specifically disclaims
any and all liability, including without limitation, consequential or incidental damages. "Typical" parameters that may be
provided in NXP data sheets and/or specifications can and do vary in different applications, and actual performance may
vary over time. All operating parameters, including "typicals," must be validated for each customer application by the

customer's technical experts. NXP does not convey any license under its patent rights nor the rights of others. NXP sells

products pursuant to standard terms and conditions of sale, which can be found at the following address:

http://www.nxp.com/terms-of-use.html.
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